Using Ektron 9

July 15, 2015

Donna Wheeler
donna.wheeler@uky.edu
# Table of Contents

Introduction .................................................................................................................................................. 4

What is Ektron? ......................................................................................................................................... 4

Aloha Editor .............................................................................................................................................. 4

UK HealthCare Website ............................................................................................................................ 4

Parts of a Web Page .................................................................................................................................. 4

Templates ...................................................................................................................................................... 5

Default Template ...................................................................................................................................... 6

Landing Template ...................................................................................................................................... 7

Home Template ........................................................................................................................................ 8

About Editing ................................................................................................................................................ 9

Logging In ...................................................................................................................................................... 9

Editing in Context ........................................................................................................................................ 11

Basic Editing ................................................................................................................................................ 16

Paragraph and Heading Styles ................................................................................................................ 16

Alignment ................................................................................................................................................ 16

Adding New Content ................................................................................................................................ 17

Deleting Content .................................................................................................................................... 17

Adding a Hyperlink .................................................................................................................................. 17

Setting a Hyperlink Target ....................................................................................................................... 22

Adding an Image .................................................................................................................................... 24

Setting Image Alignment .......................................................................................................................... 26

Setting Image Spacing .............................................................................................................................. 27

Inserting a New Image ............................................................................................................................... 29

Inserting a Link to a File ............................................................................................................................ 30

Adding a New File .................................................................................................................................. 31

Saving Your Work .................................................................................................................................... 32

Previewing Your Work ............................................................................................................................... 32

Publishing .................................................................................................................................................. 32

Editing in the Workarea .............................................................................................................................. 33

Desktop View .......................................................................................................................................... 33
Introduction
This document will give you an overview of the UK HealthCare website and the Ektron 9 Content Management System.

What is Ektron?
Ektron is a browser-based content management system, or CMS, that allows you to create and edit web pages without the use of specialized software.

Aloha Editor
Ektron 9 (and later versions) uses the Aloha editor. If you are already using Ektron 8 you will notice many differences between the old editor and the new one.

The Aloha editor is a WYSIWYG (What You See Is What You Get) editor. It is a context-sensitive editor, meaning that the tools visible to you will be different depending on what type of content you are editing. For example, if you are editing text, you will see options for styling text such as: paragraph style, headings and alignment. If you are editing an image, you may see options for alignment, borders and spacing.

UK HealthCare Website
The UK HealthCare website is organized using folders to group related content. Most editors will work only with the contents of one folder and its sub-folders.

Editors are content experts who are most concerned with the accuracy of their content. Their work is reviewed prior to publication by a publisher assigned to their service line. Publishers may make changes for clarity, accuracy and style.

At times, both editors and publishers may find they need changes to the layout, structure and function of a web page that they are not able to make without advanced coding or editing skills. The web team is available to make these changes upon request.

Parts of a Web Page
Each page on the site has a header, footer, content area and a top menu. It may or may not have a left side menu. These are controlled by the web team and cannot be changed by content editors and publishers, although they may help determine what appears in these areas.

The header, footer and menus differ from one section of the site to another. For example, Markey Cancer Center pages have the Markey name at the top and Markey contact information at the bottom, while the Gill Heart Institute pages have the Gill name at the top and Gill contact information at the bottom.
Templates
Each page is assigned a template, most often one of three primary templates that determines its layout. These are:

- Default
- Landing
- Home

There are other templates but these are the most common. The majority of the site uses the default template.

See close-up views below:
The content area may have tabs for Providers and Resources. These are created by assigning **Physician Taxonomy** and **MeSH (medical) Taxonomy** to the page. If no taxonomy is assigned, no tabs (including Overview) will appear.

The content on these second and third tabs cannot be edited. Only the primary content (Overview) can be edited. The tab names cannot be edited.
Content is divided into separate content blocks which are editable.
Content is divided into separate content blocks which are editable.

Custom tabs are created by the web team. The names and order of the tabs are specified by the content editor and can be changed by the web team. Contents on these tabs can be edited.
About Editing

There are two ways to edit using the Ektron CMS:

1. Editing in context
2. Editing in the workarea

Both methods of editing allow users to add or change text, images and links. Editing in context is faster and more WYSIWYG, but offers fewer editing tools. It is not possible to save your work as you go when editing in context. The only two options available are to quit without saving your work, or save and close the editor.

Editing in the workarea allows for more control over the appearance of the page, as well as providing additional options affecting the appearance and performance of the page, such as assigning taxonomy, search engine optimization, scheduling and custom aliases. You may save your work as you go when editing in the workarea.

Logging In

In order to edit a web page you must first log in. To do so, open a web browser (preferably Chrome) and go to: http://ekstaging.mc.uky.edu/cmslogin.aspx. Alternatively, you may go to the web site and click the link at the bottom of any page that says: “Suggest a change to this page.”

Clicking on this link opens a new page.

Do you own this content?

- CMS Editors login here.
- UK HealthCare staff who wish to edit and access from the UK HealthCare manager at 859-323-2887 or send information.

At the bottom of the page under the heading, “Do you own this content?” select the link “CMS Editors login here.” A new window will open in the browser.
You will see the page http://ekstaging.mc.uky.edu/cmslogin.aspx. You should bookmark this page to speed access in the future. Enter your user name and ID to log in.

After logging in, note the button labeled “preview.” This will allow editors to view the changes they have made to a page before the page is published. After editing a page, return to this login page and select “preview.” Reload the page you have edited and you will be able to see your edits before they are published.

Once you are logged in you may edit in context, or you may continue to the workarea to create or edit a page.
Editing in Context
To edit in context you must view the *staged* version of the UK HealthCare website at http://ekstaging.mc.uky.edu. This version of the website is identical to the live version except for any changes you and other editors may have made that have not yet been made public. You should bookmark this page to find it easily in the future.

Navigate to the page you wish to edit and look for the “switch to edit” button in the upper left-hand of the page.

Click on the words “switch to edit” and you will see one or two options, either “content” or “content” and “design.”

“Content” will automatically be selected by default. Now you will notice a light tan box around any areas that are editable.
These boxes may be difficult to see, but if you hover your cursor over each area you will see the tan box change to a black one with a menu (three horizontal lines) in the upper right corner.
Click on the menu to see your options. The black outline will turn blue.

Menu options are:

*Edit in context*
This allows you to edit the content block while still viewing the page.

*Edit*
This will take you to the workarea, where additional editing tools and options can be found

*View History*
This will show you all of the previously published versions of the content block. This is useful for reverting back to a previous version of the content without having to make any edits.

*Delete*
You will not use this option.

*Add Task*
You will not use this option.

*Properties*
This will allow you to see specific information about the content block, including the last editor, last published date, current status (approved, submitted, checked out, etc.).

*Logout*
Selecting this will log you out of the CMS and end your session.
Select “Edit in Context.”

A yellow box will appear around the content. This indicates the content is checked out to you and is ready for editing.

What do quality and safety mean to us?

Our goal with this section of our website is to provide both measures for which external agencies hold us accountable as well as measures that show how we are performing in key components of quality: patient survival, quality of care, patient safety, efficient care and patient centeredness.

We are presenting this information as accurately as possible; We are not creating any new measures or changing the scale, format or target to make ourselves look better or worse. And we’ll be clear about what’s good and what isn’t.

Why make this information public? Because we believe that our patients have the right to understand the quality of care we provide, what we are doing well and where we need to do better. We may not always look good, but it is our belief that honesty, and an honest effort to improve when and where we need to, makes for better care.

Click your cursor inside the yellow box to begin editing. The yellow box will turn blue, and editing tools will appear.
Basic Editing
The Aloha editor is a context-sensitive editor. The editing options available to you will change depending on where your cursor is on the page. If you are editing text, you will see functions much like any word processing program. You will see tools for bold, italic, headers, bullets, alignment and more.

Clicking on the downward-facing arrows will expose additional editing tools.

Paragraph and Heading Styles

NOTE: If you do not see the tools you need, click again in the content you want to edit. You may have to try more than once to reveal the correct tools.
Adding New Content
To type new content, simply place your cursor where new content is desired and begin typing. To paste new content, copy the text from the source by highlighting it and selecting “Control C,” then right-click into the page where you would like to place the new content, and select “Paste as plain text.”

Deleting Content
To delete content, highlight the content and press the “delete” key, or “Control X.” Do not use the backspace button. As mentioned earlier, Ektron is a browser-based editor. To a browser, the backspace button means “return to the previous page.”

Adding a Hyperlink
To add a hyperlink, use your cursor to highlight the text to which you wish to add a link and select the chain symbol.

The edit menu disappears and is replaced by the link field. Type or copy and paste the desired URL into the box.

Remember, you only need a complete URL for links to sites outside of UK HealthCare. For example, a link to the American College of Surgeons should look like this:

https://www.facs.org/

A link to the UK HealthCare page for surgery should look like this:

/services/adult-surgery/

It is not necessary to include the domain portion of the URL: http://ukhealthcare.uky.edu.

If the link is to another page in the site, but you don’t know what it is, you can navigate through the workarea to find it. Highlight the text as before and click on the link symbol. It will have an incomplete URL (as in the figure above). Now click on the Review tab and select the inspector (magnifying glass icon). You may need to reselect the link text to make sure the editor is properly focused on the new link.

You should see the link dialog box.
NOTE: If the link inspector does not appear, click again in the link and re-highlight the text you wish to link. You may have to try more than once to reveal the correct tools.

Clicking on the blue library symbol will allow you to browse through the *workarea* to locate the page to which you wish to link. A new dialog box will open showing all the folders on the website and their contents.
Note in the example below, the word “Library” is highlighted. The heading on the right-hand pane says “Library Folder: ‘Rootquicklinks.’” You will need to click on the folders in the left-hand pane to view content available within those folders.
Clicking on the plus symbol will open a folder to show any subfolders contained inside. To actually view the contents of the folder, you must **click on the folder’s name**. Notice the selected folder name is now highlighted and the heading on the right-hand pane now shows the folder’s name.

Make sure the dropdown box says “Quicklinks.”

Once you have navigated to the correct folder, the contents of the folder will appear in the right-hand pane.
Once you have located the correct page, double click on the name of the content block to insert the new link.

Notice the URL does not contain “http://ukhealthcare.uky.edu.” Instead, it begins with the part of the content id that comes after “.edu.”

Finish by clicking the white “X” in the upper right corner to close the Inspector.

To remove a link, highlight the text and click on the broken chain symbol. Click anywhere in the content to close the link field and return to the main editing menu.

Our goal with this section of our website is to provide both measures for which external agencies hold us accountable as well as measures that show how we are performing in key components of quality: patient survival, quality of care, patient safety, efficient care and patient centeredness.

We are presenting this information as accurately as possible. We are not creating any new measures or changing the scale, format or target to make us look better or worse. And we’ll be clear about what’s good and what isn’t.

Why make this information public? Because we believe that our patients have the right to understand the quality of care we provide. What we are doing well and where we need to do better. We may not always look good. But it is our belief that honesty, and an honest effort to improve when and where we need to, makes for better care.
Setting a Hyperlink Target

Links to sites outside of UK HealthCare should open in a new window. To set the target to a new window, you will need to “inspect” the link after creating it. Begin by highlighting the link, then select the “Review” tab on the toolbar.

Now select the Inspector by clicking on the magnifying glass icon. The Inspector dialog box will open.
Select the Advanced tab. Use the Target Frame drop-down menu to select the correct target for the link.

Finish by clicking on the white X in the upper right-hand corner to close the Inspector dialog box.
Adding an Image
To add an image, place your cursor where you would like the image to go and click on the “Insert” tab. Then click on the blue Library icon.

The library dialog box will open. Click on the name of the folder where your image is stored to display its contents. Make sure the gray bar at the top of the dialog box shows the name of the correct folder.
Make sure “Images” are selected in the drop-down menu.

Scroll down, if necessary, to locate the image and double click on it. You may click on the image itself, or on the name of the image. You may also click once on the image or name to highlight it, then click on the “Insert” icon.

The image will be inserted where you placed your cursor. Notice the text does not wrap around the image.
**Setting Image Alignment**

To set the image alignment, select the image by clicking on it. You will see a blue border around the image when it has been selected.

Open the *Inspector* by clicking on the *Review* tab. Now select the *Inspector* by clicking on the magnifying glass icon. The *Inspector* dialog box will open. Select the *check box* beside *Position & Wrapping*. You will see three options: left, none and right. Select “left.” Close the dialog box by clicking on the *white X*. The text will now wrap around the image.
**Setting Image Spacing**

To set *image space*, once again select the image by clicking on it, then click on the *Review* tab and the *Inspector* icon (magnifying glass). The *Inspector* dialog box will open.

On the *Advanced* tab, check the box next to *Spacing*. By default, the measurement is set to *ems*. If you prefer, use the drop-down menu to set the measurement to *pixels* (px), then type the amount of spacing you would like to have between the image and text (10 to 15 pixels is good). If you use *ems*, 1 is a good setting.

Finish by clicking on the *white X* in the upper right-hand corner to close the *Inspector* dialog box.
The image is now *aligned left* and the text *wraps* around the image with 15 pixels of space between the image and the text. Notice the image is also indented by 15 pixels. The editor will only add left *and* right spacing, not left *or* right spacing.

To remove the margin on the left, the HTML must be edited. This tutorial does not cover HTML editing. An alternate solution is to align the image to the right, instead of left. Even though the right side of the image will still have a 15 pixel margin, it will not be as noticeable because the right margin does not have a straight edge, as the left margin does.

---

**Advances & Insights: Neurosciences**

**December 1, 2006**

Deep brain stimulation (DBS) shows promise for depression

Deep brain stimulation

DBS is a *surgical procedure* that involves placing implantable batteries and electrodes into a targeted area of the brain that is functioning abnormally. The device is also called a brain pacemaker. The electrode is connected to a powered *stimulator*. It is used to deliver high frequency electrical signals to abnormal nerve signals in the brain, which can cause pain, movement disorders, and psychiatric disorders.

DBS does not damage brain tissue and the procedure can be reversed. The electrical currents can be adjusted if the patient's condition changes. Currently, the batteries used in the procedure typically last two or three years and are surgically replaced when depleted. Rechargeable batteries that will not have to be replaced are being developed.
Inserting a New Image

To upload a new image, place your cursor where you would like the image to go and click on the “Insert” tab. Then click on the Library icon. Make sure “Images” are selected in the drop-down menu and that you have selected the correct folder by clicking on its name in the left-hand column. Select the “ADD LIBRARY” button.

A dialog box will open allowing you to navigate to the image on your desktop or other location.
Click on the “Choose File” button to select the desired image. Give the image a meaningful title and description, i.e., “Pediatrician with patient.” When finished, click “ADD LIBRARY” to upload the new image and insert it into your content.

**Note:** Before uploading a new image, make sure it is sized and named correctly. The image should be the same size as you would like it to appear. The name should use hyphens to separate words – not underscores.

This is correct: doctor-with-patient.jpg.

This is not: doctor_with_patient.jpg.

Do not include descriptive terms which are not meaningful to the general public, i.e., “final,” “version 2” or “web version.”

**Inserting a Link to a File**

Inserting a link to a file is similar to inserting an image and creating a hyperlink. Highlight the text to which you wish to add a link. Click on the Insert tab, then click on the Library icon.
A dialog box will open. Make sure you have selected the correct folder in the left-hand pane, then use the drop-down menu on the right to select “Files.”

If the file is already in the library, click on the file to which you are linking, then click on the insert icon. The highlighted text is now linked to the file you selected. All linked files should open in a new window. Follow the instructions for Setting a Hyperlink Target to set the file to open in a new window.

Adding a New File
If you are making a link to a file that is not already in the library, follow the steps above, then click on the Add Library button. A dialog box will open.

Click on the Choose File button and navigate to the file on your desktop or other folder. Give the file a name and description, then click ADD LIBRARY. The new file will be uploaded and linked to the highlighted text.
Saving Your Work
When you are finished editing, click on the “File” tab. You will see two options: Save and Cancel.

To cancel the session and undo all changes you have made, select the red X. Your edits will not be saved.

To save your work and submit it to your publisher for review, select the blue save icon.

Do not quit your editing session by closing the browser tab or window. This will cause your work to be left in a “checked out” state, and no one else will be able to edit it. You may also lose your work.

Note: when editing in context you may not save your work without simultaneously submitting it for review by your publisher. Upon saving/submitting your work, an email is automatically sent to your publisher. If you need to save your work, but are not finished editing it, please email your publisher to let him/her know your work is not yet ready to be reviewed.

Previewing Your Work
Once you have saved your work, return to the login page and click the preview button.

Reload the page you have been editing. You should now be able to see the edits you have made.

Publishing
Once your work has been reviewed by your publisher it will be published, however, it is still not live. The content changes will go live only after the site has been synchronized.

Generally, the site will be synchronized automatically at noon and 4 p.m. There are times, however, when the site synchronization is suspended temporarily. In this case, please notify your publisher or the web team if your content must be made live immediately so a manual sync can be done.
Editing in the Workarea
In order to edit a web page you must first *log in*. To do so, open a web browser (preferably Chrome) and go to: [http://ekstaging.mc.uky.edu/cmslogin.aspx](http://ekstaging.mc.uky.edu/cmslogin.aspx). (See *Logging In*.)

Once you have logged in, select “preview,” then select “workarea.”

Desktop View
The Ektron workarea opens in *desktop view*. In the beginning it will be blank. You may need to add a new tab to your workarea before you can use it.

*Note:* It is not necessary to use the desktop area. You may skip this step if desired.
New Tab

Select the large white arrow in the upper right-hand corner to add a new tab.

Give the tab a name and click OK.

Adding Widgets

Select the arrow on the horizontal gray bar in the upper right-hand corner to open the widget tray.
The *widget tray* opens to display available *widgets*.

Drag and drop desired widgets into the desktop. Two useful widgets are “*Content Awaiting Approval*” and “*Content Checked Out*.”

**Content Awaiting Approval**

Any content *submitted* for approval by any editor will appear on the desktop. This will help you keep track of jobs you have finished that are awaiting approval by a publisher.
Content Checked Out

Any content that has been *checked out* for editing, but has not been submitted or checked in again, will appear in this widget. This will help you keep track of any projects you need to finish up and submit.
Advanced Editing

View Content

Select the Content tab in the upper left-hand corner to view contents of the website.
View Content Panes

Contents of the website are now displayed in two panes. The left pane shows the folder structure of the website and the right pane shows the contents of each folder.

The right-hand pane displays properties of each piece of content, including:

- Title
- Content Type
- Language
- ID
- Status
- Date Modified
- Last Editor
- Start Date
- End Date
Note the word “Folders” is highlighted in the left column. The gray title bar at the top says “View Contents of Folder ‘Root.’” The pane below displays only contents of the Root folder that are not located within sub-folders.

Click on the plus symbol beside the folder titled “about.” The folder expands to display the sub-folders within it. Notice that the gray bar still says “View Contents of Folder ‘Root’” and the pane below still displays the contents of the Root folder.
Now click on the **name** of the “about” folder. Notice the contents in the right-hand pane have changed, and the text in the gray title bar above the right pane now says “View Contents of Folder ‘about.’”
**Editing Existing Content**
Scroll down, if necessary, to find the content you wish to edit. Select the content by clicking on its name. You will now see a preview of that content. To open the content, click "Edit."

![Image of editing existing content](image1)

**Creating New Content**
To create a new piece of content, click on the “New” button, then select “HTML Content” from the drop-down menu.

![Image of creating new content](image2)
**Title**

Give the new content a name by typing it in the box labeled “Title.” This is the title that will appear on a browser tab when viewed on the web, so make sure it is a good, meaningful title.

**File Options**

Note the file options. Unlike editing in context, editing in the workarea allows you to save your work without submitting for review by your publisher.

You may:

1. **Submit** your work for review by your publisher.
2. **Undo checkout** (cancel).
3. **Check in** your work so that you may return to it later and continue editing.
4. **Save** your work as you go, to make sure you do not lose any work.
5. **Preview** your work.

Always use cancel, submit, undo checkout or check in when you are finished editing. **Do not quit your editing session by closing the browser tab or window.** This will cause your work to be left in a “checked out” state, and no one else will be able to edit it. You may also lose your work.
Adding Content

Adding content is the same in the workarea as it is when editing in context. You may type in the content area or you may copy and paste plain text. See “Basic Editing” for details on primary editing tasks.
Expand Editing Tools
This is the same as in Basic Editing.

Paragraph and Heading Styles
Alignment

Formatting Text
Formatting text is very similar to most word processors. Simply highlight the text and select the desired style. See Basic Editing.
**Heading**
The main page heading should use the *H1* or *Heading 1* style.

Creating a Link
Creating a link is the same in the workarea as it is when editing in context. Highlight the desired text and click on the *link* symbol to add a hyperlink. See *Basic Editing, Adding a Hyperlink*. 
Type the link in the box.

Review Link Properties
Select the Review tab. See Basic Editing, Setting a Hyperlink Target.
Click on the inspector symbol to see and edit the link’s properties. See Basic Editing, Setting a Hyperlink Target.

When finished, close the inspector by clicking on the white X in the upper right corner.
Working with Images
Inserting an image from the library and adding a new image to the library are much the same as in editing in context. See Basic Editing, Adding an Image.

Place your cursor where the image should go, click on the insert tab, then click on the library symbol.

Formatting an image
The workarea provides more options for formatting an image than are found when editing in context. Select the image and click on the Review tab, then click on the Inspector symbol.
Select the advanced tab to add or edit *Alt Text* and set the *Position & Wrapping, Spacing* and *Border* for the image.
Size
Because our site uses responsive design, you should not adjust the size of your image with this setting. Using this option will cause your image to no longer be responsive. It will not resize for phone and tablet.
**Position & Wrapping**

You may choose, Left, None or Right.
**Spacing and Margin**

Add space to the *Horizontal Margin* to prevent text from touching the image (usually 10 to 15 px.). Use the drop-down box to select *PX* and enter the desired amount of spacing. You may also need to change the *Vertical Margin*. The editor can only adjust BOTH left and right, or top and bottom margins. If you need to change only one margin, you must edit the HTML.
**Setting the Border**

A border is not usually necessary unless the background of the image is white, or nearly white. In most cases, colored borders should not be used. Use a light gray instead, by entering the HEX Code c0c0c0. A thickness of 1 px is usually all that is needed.
**Editing HTML**

Advanced editing may be done by editing the HTML. The *Aloha Editor* has a much improved HTML editor. Start by selecting the *Review* tab, then click *View Source*.

You may see an error message asking you to “set focus.” Simply click on the item you wish to edit and then select *Review* and *View Source*.

The HTML appears in a new window.
Make the desired changes to the HTML and click on the white X in the upper right corner to exit the HTML editor. (This tutorial does not cover editing HTML.)

**Setting Advanced Properties**

Editing in the workarea allows for setting additional properties that are not available when editing in context.

In addition to the *Content* tab, where most work is done, there are tabs for these additional properties:

- **Summary**
- **Metadata**
- **Aliases**
- **Schedule**
- **Comment**
- **Template**
- **Category**
Summary
The summary is used by search engines to help locate appropriate content on the site.

Title: The Ektron workarea

Enter description here.
**Metadata**

The Metadata tab provides an additional opportunity for search engine optimization.

Fields include:
- Keywords
- Description
- Tags
- Image data
**Aliases**

Multiple manual *aliases* may be added. At least one alias is required for any content using a sub-site template, such as Markey Cancer Center or Gill Heart Institute. In order to present the correct sub-site header, footer and menu, the primary alias must begin with the correct site prefix. For example:

- Markey Cancer Center aliases begin with /markey/
- Gill Heart Institute aliases begin with /gill/
- Kentucky Children’s Hospital aliases begin with /kch/

All aliases should end with a slash. Use the drop-down menu to select the slash. Make sure to check “Active” to activate the alias. If the alias is the primary alias for the page, select “Primary” as well.
**Schedule**
Content may be created and set to go live at a later date. It may also be set to expire. Select the date using the calendar icon on the left and remove a date using the icon on the right. Leave the default setting for “Action on End Date.”

![Image showing schedule settings](image)

**Comment**
Comments are not visible to the public. Comments can be useful in tracking changes.

![Image showing comment section](image)

**Template**
The template does not usually need to be changed. The default setting is one_default. If necessary, use the drop-down menu to select the correct template.

![Image showing template selection](image)
**Category**
The category tab allows Physician and MeSH taxonomy to be applied to the content. Click on the plus symbol to expand categories and locate the correct taxonomy. Any content in a default template will display Related Physicians and Related Resources when taxonomy is applied.
Preview
To see your edits as they will appear in the finished page, select “Preview.” A dialog box will open asking you to select portrait or landscape orientation. It does not matter which one is selected. Make a selection and click Preview. The page will open in a new browser window.

If you are using a pop-up blocker you may need to disable it. Once the preview is loaded, you may continue editing your page. Each time you save your work you can refresh the preview page to see the new layout.

Saving Your Work
Editing in the workarea offers more file options than editing in context. File options in the workarea are:

1. **Submit** your work for review by your publisher.
2. **Undo checkout/cancel.** (Selecting this option will abandon your work.)
3. **Check in** your work so that you may return to it later and continue editing.
4. **Save** your work as you go, to make sure you do not lose any work.

Always use submit, undo checkout or check in when you are finished editing. **Do not quit your editing session by closing the browser tab or window.** This will cause your work to be left in a “checked out” state, and no one else will be able to edit it. You may also lose your work.